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RINGKASAN 
 

Pelatihan ini untuk menambah keahlian bagi karyawan muda yang baru 

lulus kuliah atau yang sedang bekerja maupun yang dalam kondisi tidak ada 

pekerjaan, dimana keahlian ini tidak perlu mengikuti perkuliahan di bangku 

kuliah, keahlian yang diberikan berupa cara mendesain baju kerja PDL. 

Permasalahan mitra salah satu terbentur dengan SDM yang kurang sebagai 

pengajar keahlian tersebut. Pelatihan ini disepakati dengan pengurus KKMK 

yang bekerjasama dengan tim PKM. Pelatihan untuk mempelajari keahlian 

mendesain baju kerja PDL dan edit gambar yang dapat diaplikasikan pada baju 

kaos. Pelatihan di bagi dalam 2 sesi dengan 2 materi yang berbeda dan dihadiri 

oleh 8 orang peserta. Pelatihan dilakukan dalam kelas, dengan masing-masing 

peserta menggunakan laptop masing-masing yang sudah di pasang software 

adobe photoshop. Pelatihan membuat edit photo dengan efek kartun dan desain 

baju kemeja PDL. Hasil akhir dari pelatihan ini yaitu semua peserta mampu 

menghasilkan desain baju yang kemudian di pilih salah satu untuk di cetak baju 

PDL. Luaran dari kegiatan ini akan diseminarkan dalam seminar ilmiah.    

  

Kata Kunci : pelatihan photoshop, menambah keahlian karyawan muda, desain 

baju kerja PDL 
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BAB 1 

PENDAHULUAN 

 

1.1 Analisis Situasi 

Kelompok Karyawan Muda Katolik atau KKMK berdiri dari tahun 1999. 

KKMK Paroki St.Kristoforus dibentuk sebagai wadah untuk mengumpulkan dan 

mengorganisir karyawan muda Katolik yang berada di Paroki St.Kristoforus. 

Dalam rangka mempererat rasa persaudaraan dan kebersamaan yang dituangkan 

dengan menyumbangkan tenaga dan pikiran demi perkembangan diri antar sesama 

anggota, diaplikasikan dengan saling membagi ilmu yang berbeda antar anggota 

dengan anggota lain yang membutuhkan.   

Dengan adanya wadah ini, diharapkan kegiatan yang dilakukan mampu 

memotivasi karyawan muda Katolik yang ada di KKMK St. Kristoforus untuk 

selalu berkreasi, baik di lingkungan kerja maupun di lingkungan gereja dan 

masyarakat. Dan secara umum mengembangan generasi muda yang berkualitas 

unggul.   

Para anggota KKMK ini adalah orang dengan range baru kerja sampai umur 

maksimum 35 tahun dan harus belum menikah. Semua anggota tidak harus 

beragama Katolik saja, tetapi terbuka untuk umum yang mau berkegiatan 

bersama-sama. Wadah ini dibentuk untuk anggota saling berbagi ilmu, keahlian 

dan sukaduka. Banyak kegiatan yang dibentuk untuk menampung semua aspirasi 

anggota, mulai dari belajar dansa salsa, belajar bahasa inggris dan mandarin, 

belajar gitar. Semua dari anggota untuk anggota, yaitu pengajar dari sesama 

anggota untuk dibagikan kepada anggota. Setiap hari sabtu diadakan sarasehan, 

yaitu mengadakan seperti seminar tetapi tidak secara formal, dimana sarasehan ini 

untuk berbagi ilmu atau sekedar berbincang-bincang antar sesama anggota. 

Sarasehan untuk membuat anggota saling mengenal satu sama lain, karena setiap 

hari dengan kegiatan berbeda mempunyai anggota peserta kegiatan yang berbeda 

pula. Kelompok KKMK kristoforus ini dibawah pengawasan Pastor 

St.Kristoforus.  yang bertempat di jelambar Jakarta barat. 
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Kelompok KKMK ini terletak di kompleks gereja St.Kristoforus daerah Jelambar, 

lokasi dekat dengan kampus, hanya berjarak kurang dari 3 km.  

Alamat lokasi kelompok ini : Jl. Satria IV No.Blok C, RT.9/RW.Nmr 68, 

Jelambar, Kec. Grogol petamburan, Kota Jakarta Barat, Daerah Khusus Ibukota 

Jakarta 11460,  Indonesia 

Nomor Telepon : (021) 5602644 

Kelompok ini terus menerus mengembangkan diri, dengan menyuguhkan 

pelatihan-pelatihan yang di dominasi dari saling berbagi. Oleh karena itu pelatihan 

ini merupakan salahsatu kegiatan untuk memberikan ilmu tambahan untuk para 

anggota. Diharapkan hasil dari pelatihan ini dapat bermanfaat bagi para anggota. 

 

1.2.  Permasalahan Mitra 

 Pengurus KKMK mengalami kekurangan tenaga pengajar yang 

mempunyai keahlian di bidang penggunaan aplikasi photoshop, khususnya desain 

gambar untuk kaos yang dapat menambah keahlian para peserta dan juga dapat 

menambah uang pendapatan para anggota.  

 

1.3. Uraian Hasil PKM Terkait 

Kegiatan PKM ini merupakan kegiatan untuk memulai kerjasama dengan 

kelompok KKMK St.Kristoforus dimana para anggotanya merupakan karyawan 

muda yang masih bersemangat untuk mengembangkan diri.. Pelatihan akan 

dilaksanakan diruangan kegiatan KKMK yaitu di lingkungan gereja atau sekolah 

Kristoforus.   

Peserta pelatihan untuk maksimum 10 orang dengan masing-masing 

membawa laptop yang sudah di install software adobe photoshop. Setiap peserta 

akan mengikuti 2 sesi pelatihan secara keseluruhan. Pelatihan tersebut mempunyai 

materi : 

 Materi 1 = pendahuluan, memuat materi pelatihan meng-edit photo 

dengan efek kartun 

 Materi 2 = membuat desain baju kemeja PDL untuk anggota KKMK 
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Tim PKM menyediakan semua kebutuhan dari software adobe photoshop, sampai 

hasil akhir untuk di buat kemeja PDL sebagai luaran tambahan. Pelatihan seperti 

pembelajaran di kelas secara langsung praktek. pelatihan diberikan dengan alat 

bantu LCD projector dan laptop, serta bahan materi dalam bentuk file PDF.  
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BAB 2 

SOLUSI PERMASALAHAN DAN LUARAN 

 

2.1 Solusi Permasalahan  

 Solusi yang ditawarkan bisa berupa video pelatihan, seminar atau workshop. 

Solusi yang dipilih adalah pelatihan workshop dengan praktek langsung membuat 

sebuah desain baju kemeja PDL menggunakan software photoshop. Pelatihan 

dengan hasil akhir dengan pembuatan baju hasil desain. Pembekalan anggota 

KKMK untuk dapat mengembangkan menjadi sebuah usaha desain baju.  

Diadakan pelatihan yang berisikan 2 sesi dengan 2 materi. dengan jumlah 

peserta 10 orang maksimum, untuk pengajaran yang maksimum. Jumlah pengajar 

3 orang yang terdiri dari 2 orang mahasiswa dan 1 orang dosen. Pelatihan 

dilaksanakan secara luring dan membutuhkan waktu maksimal 3 jam untuk setiap 

sesi. Kegiatan diawali dengan penjelasan pendahuluan, desain photo dengan efek 

kartun dan desain baju kemeja PDL. Waktu pelatihan pada tanggal 17 Juni 2023.  

 

2.2  Luaran Kegiatan 

Target luaran yang diharapkan dari kegiatan ini adalah melalui seminar 

nasional dan luaran tambahan berupa desain baju kemeja PDL.  

Tabel 2.1 Jenis Luaran dan Luaran Tambahan 

No Jenis Luaran Keterangan 

Luaran Wajib 

1 Publikasi ilmiah pada jurnal ber ISSN atau Draft/sudah sumbit 

2 Prosiding dalam Temu ilmiah senapenmas 

Luaran Tambahan  

1 Publikasi di jurnal Internasional  Draft/sudah sumbit 

2 Publikasi di media massa Draft/sudah sumbit 

3 Hak Kekayaan Intelektual (HKI) Draft/terdaftar 

4 Teknologi Tepat Guna (TTG) Draft/sudah disusun 

5 Model/purwarupa/karya desain atau Baju PDL dibuat 

6 Buku ber ISBN Draft/sudah disusun 
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BAB 3  

METODE PELAKSANAAN 
 

3.1 Langkah-langkah / Tahapan Pelaksanaan  

 Tahapan pelaksanaan kegiatan PKM ini : 

 Menghubungi ketua KKMK yaitu saudara Adrianus, menawarkan perihal 

pelatihan dan kerjasama. 

 Rapat tim 

 Mempersiapkan materi pelatihan dan bahan pendukung 

 Menguji  materi dan pembuatan petunjuk pelatihan  

 Mempersiapkan modul pelatihan sebagai bahan materi pegangan bagi 

peserta dan ppt 

 Rapat tim 

 Persiapan akhir 

 Pelaksanaan pelatihan 

 Mengumpulkan data dan menganalisa, serta membuat laporan 

 Membuat draft artikel luaran 

 Membuat laporan monev 

 Membuat laporan akhir, laporan keuangan, dan logbook. 

 Membuat luaran tambahan 

Tahapan atau langkah-langkah ini dapat berubah menyesuaikan dengan kondisi di 

lapangan, perubahan demi kelancaran kegiatan PKM ini. 

 

3.2 Partisipasi Mitra Dalam Kegiatan PKM  

Partisipasi mitra dalam kegiatan ini dengan mengkoordinir peserta 

pelatihan, menyediakan ruang  untuk pelaksanaan kegiatan,  menjalin kerjasama 

selanjutnya dengan prodi Teknik Elektro Untar. 

 

3.3  Kepakaran dan Pembagian Tugas TIM 

Berikut uraian kepakaran dan tugas masing-masing anggota tim :  
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Tabel 3.1 Uraian Kepakaran Anggota Tim 

Nama Kepakaran Tugas 

Suraidi.,ST.,MT 

Elektronika, 

kontrol, 

telekomunikasi, 

photoshop, listrik 

satu phasa. 

 Pengajar pd pelatihan 

 Membuat materi pelatihan 

 Membuat semua laporan 

 Follow-up pihak mitra 

 Membeli modul 

 Membuat artikel 

 Menguji sistem yang digunakan 

 Membuat monev 

 Membuat laporan akhir 

keseluruhan 

 Membuat luaran tambahan 

Julius Sembiring Photoshop    
 Pengajar pd pelatihan  

 Membuat materi pelatihan 

Richardo 

Ariyanto 
Photoshop    Pengajar pd pelatihan 
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BAB 4 

HASIL DAN LUARAN YANG DICAPAI 

 

4.1 Hasil Yang Dicapai 

Kegiatan PKM ini mengajarkan cara mendesain kemeja PDL dan meng-edit 

foto dengan efek kartun. Pelatihan dilakukan secara detail tiap langkah untuk 

memandu peserta dalam pelatihan, dan tidak menutup kemungkinan para peserta 

dapat memodifikasi hasil pelatihan secara langsung. 

Pelatihan pertama yaitu mendesain baju kemeja PDL (pakaian dinas 

lapangan). Langkah detail disajikan dalam bentuk file pdf, sehingga peserta dapat 

mengikuti setiap langkah secara detail, serta fasilitator juga mendemokan setiap 

langkah tersebut dengan bantuan laptop dan LCD projector. Langkah detail 

pelatihan dapat dilihat pada lampiran. Hasil desain dari materi pelatihan dapat 

dilihat pada Gambar 4.1.  

 
Gambar 4.1. Desain Kemeja Materi Pelatihan 

Sedangkan hasil pelatihan dari para peserta dapat dilihat pada Gambar 4.2 sampai 

Gambar 4.5 berikut : 
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Gambar 4.2 Hasil Desain Peserta 1 

 

Gambar 4.3 Hasil Desain Peserta 2 

 

Gambar 4.4 Hasil Desain Peserta 3 
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Gambar 4.5 Hasil Desain Peserta 4 

Hasil pelatihan dapat di lihat mempunyai beberapa variasi dari masing-masing 

peserta. Ada satu hasil desain yang di pilih untuk dibuatkan kemejanya, yaitu 

sesuai dengan desain Gambar 4.3. dan ada beberapa modifikasi untuk 

menyesuaikan, sehingga hasil desain yang di buat sesuai dengan Gambar 4.6 dan 

Gambar 4.7. 

 

Gambar 4.6 Hasil Desain 1 yang Di Buat Bajunya 
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Gambar 4.7 Hasil Desain 2 yang Di Buat Bajunya 

Hasil desain 1 yang dibuat akan diberikan kepada para peserta yang berjumlah 8 

orang peserta, sedangkan hasil desain 2  dibuat untuk tim PKM dari Untar yang 

berjumlah 3 orang. 

 

Foto kegiatan pelatihan  

 

Penjelasan materi 

pelatihan 

 

Saat pelatihan  
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Saat pelatihan 

 

Saat pelatihan dan 

dibantu oleh 

mahasiswa 

 

Saat pelatihan  

 

Pelatihan kedua adalah meng-edit foto dengan efek kartun. (materi pelatihan 

dapat dilihat di lampiran). Foto yang dicoba untuk di edit seperti pada Gambar 

4.8. 

 

 

 
Gambar 4.8 Materi Mengedit Foto Dengan Efek Kartun 



12 
 

Hasil dari para peserta diperlihatkan pada Gambar 4.9. 

       
Gambar 4.9 Hasil Pelatihan dari Peserta 

Hasil gambar ini dapat diaplikasi pada kaos, sehingga para peserta diharapkan 

mempunyai keahlian untuk mengedit foto lain yang mempunyai nilai komersial 

untuk aplikasi pada kaos. 

Foto Kegiatan 

 

Hasil desain dari peserta 

 

Saat pelatihan 

 

Saat pelatihan  
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Suasana pelatihan 

 

Foto bersama setelah pelatihan selesai seperti pada Gambar 4.10 

 

Gambar 4.10 Foto Bersama 

 

4.2 Luaran yang Dicapai 

Luaran yang dicapai oleh tim PKM  mengikuti seminar Senapenmas 2023. 
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BAB 5 

 KESIMPULAN DAN SARAN 

 

5.1 Kesimpulan 

Kesimpulan yang dapat diambil dari pelatihan ini adalah : 

1. Pelatihan berjalan dengan baik, semua peserta berhasil mendesain baju kemeja 

dan desain foto dengan efek kartun. 

2. Peserta mempunyai kreatifitas dalam melakukan desain, khususnya desain 

baju kemeja PDL. 

3. Semua peserta memahami dan berhasil melakukan desain secara baik. 

 

Saran yang dapat diambil dari pelatihan ini : 

1. Diadakan kerjasama dalam bidang lain. 

2. Mengembangkan jenis pelatihan yang lain untuk keahlian praktis siap pakai.  
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LAMPIRAN 

 

Photo to Cartoon Effect 

1. Buka photoshop 

2. File => Open => Pilih gambar yang diinginkan 

Link gambar yang dipakai: 

https://media.gettyimages.com/id/73510827/photo/mr-beans-holiday-

photocall.jpg?s=612x612&w=gi&k=20&c=xkXg2_cf4saVyXsHj6lhLka2

qzwn6KB_pJkfjCtFkks= 

3. Layer => buka layer yang dikunci dengan meng-tap symbol lock nya 

4. Lanjut ke tools => Pen Tool (P pada keyboard) 

5. Setelah selesai menggunakan Pen Tool, dilanjutkan dengan klik bagian 

kanan pada mouse dan pilih make selection 

6. Setelah selesai tahap 5, pada layer background klik CTRL + J pada 

keyboard untuk menduplikat layer tersebut 

https://media.gettyimages.com/id/73510827/photo/mr-beans-holiday-photocall.jpg?s=612x612&w=gi&k=20&c=xkXg2_cf4saVyXsHj6lhLka2qzwn6KB_pJkfjCtFkks=
https://media.gettyimages.com/id/73510827/photo/mr-beans-holiday-photocall.jpg?s=612x612&w=gi&k=20&c=xkXg2_cf4saVyXsHj6lhLka2qzwn6KB_pJkfjCtFkks=
https://media.gettyimages.com/id/73510827/photo/mr-beans-holiday-photocall.jpg?s=612x612&w=gi&k=20&c=xkXg2_cf4saVyXsHj6lhLka2qzwn6KB_pJkfjCtFkks=
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7. Lanjut create New Layer => create New Fill => Solid Color 

 

8. Klik New Layer (Color Fill 1) lanjut ke tool Crop Tool (C pada keyboard) 

 
9. Klik Layer 1, klik Image => Adjustment => Levels 
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10.  Lanjut ke Image => Adjustments => Curves  

 

11. Lanjut menduplicate layer 1 => layer 1 copy 2 dengan klik CTRL+J, 

kemudian klik ke layer 1 dan ikuti tahap nomor 4-6 pada bagian kepala, 

lanjut dengan klik CTRL+SHIFT+J dan lanjut dengan CTRL+T, 

kemudian  dilanjutkan dengan rename layer menjadi nama “kepala” pada 

layer tersebut 

 

12.  Lanjut dengan Pen Tool ke layer tersebut pada bagian telinga, kemudian 

ikuti tahap nomor 4-6, lanjut dengan klik CTRL+SHIFT+J dan lanjut 

dengan CTRL+T, kemudian dilanjutkan dengan rename layer menjadi 

nama “Kuping” pada layer tersebut 
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13.  Lanjut pada layer kepala, klik filter => Liquify => ikuti istruksi pada 

gambar dibawah ini 

 

14.  Lanjut pada layer kepala, lakukan pen tool pada bagian hidung dengan 

mengikuti tahap nomor 4-6, dilanjutkan dengan klik CTRL+J dan lanjut 

dengan CTRL+T, lanjut ke bagian Edit => Transform => Wrap untuk 

mengatur tingkat kesamaan pada bagian wajah, kemudian  dilanjutkan 
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dengan rename layer menjadi nama “Hidung”   
15. Lanjut pada layer kepala, lakukan pen tool pada bagian bibir dengan 

mengikuti tahap nomor 4-6, dilanjutkan dengan klik CTRL+J dan lanjut 

dengan CTRL+T, lanjut ke bagian Edit => Transform => Wrap, kemudian  

dilanjutkan dengan rename layer menjadi nama “Bibir” pada layer 

tersebut. 

  

16.  Lanjut buka tools => Smudge Tools dan usap pada bagian badan, kepala, 

telinga, dan hidung seperti pada gambar di bawah kanan ini. 
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17.  Setelah selesai menggunakan Smudge Tools, pencet tahan SHIFT + layer 

badan dan layer telinga, kemudian pencet CTRL+ G untuk membuat grup 

pada layer-layer tersebut dan duplikat grup tersebut dengan CTRL+J 

18.  Lanjut pada group 1, klik kanan pada mouse => pilih Ungroup Layers dan 

lanjut pilih Merge Layers dan setelah itu lanjut rename layer tersebut 

menjadi “edit” 

 

19. Lanjut pada layer edit => Filter => Sharpen => Unsharp Mask => Ikuti 

instruksi pada gambar pada dibawah ini 
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20. Lanjut kembali ke Smudge Tool => Usap pada bagian rambut dan badan 

seperti pada gambar dibawah ini 

 

21. Setelah Smudge Tool => lanjut ke Dogde Tool => Usap pada bagian 

badan dan wajah guna untuk mencerahkan bagian tersebut  
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22. Setelah tahap semuanya selesai, berikut hasil jadi gambarnya. 
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Membuat desain baju PDL 

 

1. Buka photoshop 

2. Klik “file”  new 

 

 
 

3. Size A4, dengan merubah “preset”  pada “international paper”, lalu klik 

“ok” 

 
Akan tampil lembaran kosong putih dengan ukuran A4 secara portrait 

 

4. Posisi kertas diubah menjadi  landscape  Image  Image rotation  

90o CW 
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Lembaran putih tadi akan berputar menjadi landscape posisinya 

 

5. Kemudian klik “rectangle tool”, pilih yang berbentuk kotak 
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6. Tekan shift + klik mouse dan geser untuk membuat sebuah kotak (fungsi 

menekan “shift” agar kotak berbentuk bujur sangkar) 

 

 
 

 

7. Ubah warna kotak tersebut menjadi hitam, dengan cara klik pada “Fill” 

dan pilih warna hitam 

 
Maka kotak akan berwarna hitam 
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8. Klik “Edit”  Free Transform Path 

 
Lalu klik icon”switch between …..”  berikut : 

 
 

Lalu klik pada bagian “Custom” , pilih “Shell upper” 
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Maka gambar akan menjadi : 

 
 

Lalu ubah nilai Bend = 20 
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Kemudian  klik √ 

 
 

 
 

9. Langkah berikutnya, yaitu membuat kotak yang sama seperti pada awal 

permulaan (langkah no.5 sampai no.7), lalu langkah no.8 hampir sama 

tetapi yang dipilih bukan “Shell Upper” tetapi “Squeeze” dengan nilai 

Bend = 20 %, dan jangan lupa dengan √ 
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1. Bentuk desain 

yang layer 1, 

diawal  

(layer Rectangle 

1) 

 

 

2. Bentuk desain 

yang layer 2, yang 

berikutnya 

(layer Rectangle 

2) 

 

10. Gabungkan gambar 1 dan gambar 2 diatas, dengan klik tanda   , lalu 

tekan mouse sambil digeser-geser. Jika ukuran berbeda dapat dikecilkan 

atau dibesarkan agar pas dengan cara, klik layer yang dimau dan lakukan 

langkah : Edit  Transform Path  Scale, sehingga muncul kotak, baru 

rubah ukurannya. 

 
Misalkan pada layer 2 dilakukan langkah tersebut maka gambar seperti : 
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Jika sudah selesai merubah, jangan lupa √ 

 

11.  Gabungkan kedua layer tersebut jika sudah dalam posisi yang benar, dengan 

cara tekan tombol “Ctrl” + klik layer 1 dan klik layer 2 (tombol “Ctrl” ditekan 

terus), setelah kedua layer tersebut ter-block  tekan Ctrl + E (maka akan 

menjadi 1 layer tergabung) 

 

 

 

 

12. Berikutnya membuat kerah  kotak yang ke-3 dengan ukuran lebih kecil 

(Rectangle tool  menggunakan mouse klik awal dan ditekan terus 

sambil digeser untuk membentuk sebuah persegi) dan diletakkan diatas 

seperti pada gambar : 
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13. Lalu pada layer “kerah”, Edit  Free Transform (pada layer kerah akan 

muncul kotak) lalu tekan Ctrl + Shift + Alt bersamaan dan tekan terus 

serta geser ujung kotak bagian kanan atas ke dalam, sehingga membentuk 

seperti gambar : 

 
14. Masih untuk layer kerah.  Edit  Free Transform  “Switch 

between…..”  Custom diganti Arc Upper (titik tengah atas ditarik 

kebawah untuk membentuk lengkungan pada kerah), jika sudah selesai 

jangan lupa √ 

 
 

15. Kemudian layer kerah digabung dengan layer badan, kedua layer tersebut 

di block, lalu tekan Ctrl + E 

 

16. Layer lengan  Rectangle tool  buat kotak, lalu bagian bawah 

dikecilkan sedikit (Edit  Free Transform  Ctrl + Shift + Alt + geser 

bagian bawah  
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Lalu putar sedikit (mouse diarahkan kebagian tengah, akan muncul panah 

menunjukkan putar, putar sedikit dengan klik mouse terus geser) 

 

 

 

Jangan lupa √ jika sudah. 

Lalu layer ini gabungkan pada bagian lengan dari baju (move tool  geser 

layer lengan ini ke bagian lengan baju) 

 
 

Untuk lengan yang sebelah kiri  klik layer lengan, lalu klik kanan 

mouse  pilih duplicate layer (klik move tool  tekan mouse sambil 

geser akan terlihat hasil duplicate nya  Edit  Transform Path  Flip 

Horizontal, lalu pindahkan ke bagian lengan sebelah kiri 
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17. Layer tangan kanan dan kiri digabung dan diberi nama “tangan” 

18. Layer badan diberi nama “badan” 

 
Lalu layer “tangan” dipindah dibawah layer “badan”, dengan cara klik 

mouse pada layer, tahan kliknya lalu geser. 

 

19. Jika mau membesarkan atau mengecilkan size gambar, yaitu dengan : 

block layer  Edit  Transform Path  Scale, lalu tinggal ubah 

20. Langkah berikut akan diberikan motif pada bagian depan, dengan 

menggunakan “Pen Tool” 

 
21. Lakukan beberapa titik untuk membentuk seperti ini: 
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22. Klik kanan pada layer shape tersebut, pilih “Create Cliping Mask”, lihat 

apa yang terjadi ? apakah akan berubah menjadi : 

 
23. Perhatikan bahwa layer “shape” ini terletak paling atas di urutan layer 

24. Langkah berikutnya pada bagian lengan kanan dan kiri diberikan 

kombinasi warna dengan cara yang sama, agar lebih mudah dengan 

menghilangkan tampilan bagian badan (dengan me-non-aktifkan layer 

“badan”), klik bagian icon “mata” pada bagian kiri pada layer “badan” 

 

 

 

 

     Gambar yang semula : 
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 

 

 

Dengan menggunakan “pen tool”, dengan cara yang sama : 

 
Dengan pilih “Create Cliping Mask”, maka akan seperti : 

 
Perhatikan urutan layer : 
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Layer “shape 3” untuk modifikasi warna tangan harus terletak tepat diatas 

layer “tangan”, seperti pada layer “shape 2” sebelumnya!!!! 

Jika layer “badan” diaktifkan, maka gambar akan seperti : 

 
25. Semua layer dijadikan satu, dengan blok semua layer lalu dijadikan satu 

dalam group (Ctrl + G). beri nama group ini dengan “depan” (karena ini 

bagian depan dari baju walau belum selesai dalam men-desain. 

 
26. Duplicate group, dengan klik kanan pada layer group “depan” dan pilih 

“Duplicate group” dan sekalian diberi nama “belakang” 

 
Pada gambar masih terlihat satu, klik “move tool”, lalu rubah pada bagian 

atas menjadi “group”  

 
Klik pada gambar (tekan terus) dan geser ke kanan, maka akan terlihat 

menjadi 2 gambar.  
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Agar tidak keliru dapat diberikan keterangan dengan tulisan pada masing-

masing bagian dengan input Text (klik T pada icon, dan klik dibagian 

mana tulisan akan di ketik, kemudian ketik “Depan”, sesuaikan ukuran 

huruf) 

 

 
 

27. Focus pada bagian depan, yaitu dengan me-non-aktifkan yang lain, selain 

group “depan” 

28. Buka group “depan” dengan klik gambar segitiga kecil pada bagian depan 

layer “group depan” 
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 

 

 

 

29. Focus pada bagian badan (non-aktifkan bagian lengan) 

 
 

 

30. Membuat kerah dengan bantuan “Polygon tool”, isi Sides = 3 (untuk 

membentuk segitiga. Untuk segitiga sama sisi waktu membentuk segitiga 

sampil menekan tombol “Shift”. 

 dengan  

 

 Lalu dipanjangkan sedikit (Edit Free Transform): 
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Lalu duplicate layer, dan geser 

 
Ubah bentuk yang sebelah kanan menjadi segitiga siku, dengan Edit  

Free Transform, lalu tekan tombol Ctrl sambil ditarik titik kiri atas kearah 

kiri. 

 
Lalu segitiga kiri diubah sedikit dengan cara yang sama, tetapi ditarik 

kearah kanan sedikit : 

 jangan lupa √ 

Lalu dikecilkan sedikit size nya, Edit  Transfrom  Scale 

 jangan 

lupa √ 

Lalu kedua layer kerah ini disatukan, dengan memblock kedua layer dan 

Crtl+E 

Putar kerah ini menjadi tegak : 
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Kemudian dibuat agak melengkung sedikit, Edit  Free Transform, lalu 

klik “Swicth Between …..” /  , Custom diganti “Arc”, Bend = 10 dan 

klik , maka gambar menjadi : 

 

 
Layer ini di dalam group layer “badan”, lalu tempatkan dibagian gambar 

badan sebagai kerah bagian kiri, agak diputer dikit dengan EditFree 

Transform (disesuaikan, dan jangan lupa klik kanan mouse “Create 

Clipping Mask). 

Untuk bagian kanan kerah, layer tersebut di duplicate dan Edit  

Transform  Flip Hozirontal, kemudian digeser disesuaikan tempatnya. 

Jika sudah selesai, maka gambar akan seperti : 
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31. Membuat list kancing, dengan bantuan “Rectangle tool”, membuat persegi 

panjang sepanjang bagian depan badan. Warna hitam tanpa pinggiran, lalu 

duplicate layer dengan warna biru. Layer yang biru harus dibawah layer 

yang hitam, kemudian geser sedikit ke kiri untuk layer biru, untuk 

menimbulkan efek list warna biru. 

 
Jika layer tangan diaktifkan maka gambar akan seperti : 
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32. Beri efek gelap pada bagian dalam kerah dengan bantuan “Pen tool” dan di 

isikan dengan warna abu-abu, ada 2 layer dengan warna abu-abu muda dan 

tua, seperti gambar : 

 
 

33. Beri kantong pada bagian dada kiri dengan bantuan “Rectangle tool”, 

caranya sama seperti membuat list kancing. 

 
 

34. Dada kanan untuk nama, dengan bantuan “Rectangle tool” dengan 

menggunakan list warna biru. 
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35. Input Text untuk menuliskan nama masing-masing di dalam kotak dada 

sebelah kanan.  

 
Atur warna dan ukuran huruf, misalkan warna putih untuk huruf 

 
 

36. Masukkan logo KKMK di atas kantung (dada kiri), seperti pada gambar 
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Logo lembaga harus berupa file PNG, yaitu gambar dengan background 

transparent, untuk memudahkan aplikasi gambar pada desain. 

 

37. Bagian depan baju sudah selesai, sekarang bagian belakang. Aktifkan layer 

group belakang dan non-aktifkan layer group depan. Kemudian buka 

group belakang. 

 

38. Dengan menggunakan “Pen tool” membuat bagian atas menjadi warna lain 

(jangan lupa “Create Clipping Mask”, gambar menjadi : 

 
 

39. Bagian kerah warna hitam, dengan menggunakan “Pen tool” 

 

 
 

40. Berikan tulisan dibagian belakang  



46 
 

 
 

41. Hasil pelatihan selesai, dengan desain akhir : 

 
Selamat mencoba!!!! 
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